
Equation Solving 
 
We begin with a very simple problem. 
 
1.  Enter the equation a+b = c*d on the Rule Sheet.   
 
TK automatically places the variable names on the Variable Sheet.  Variable names are 
case sensitive -- a and A are not the same in TK.  Also notice that TK placed a "*" 
symbol in the status column next to the equation.  Move the cursor over the * and note 
that the status bar at the bottom of the screen reads, "Unsatisfied."  You may also click 
and drag on the column separator to expand a column.  Equations are also displayed in 
MathLook view at the bottom of the screen.  If the MathLook view is not displayed, use 
the View menu to activate it. 
 
2.  Activate the Variable Sheet and enter values of 2, 3, and 4 in the input column for the 
variables a, b, and c.  We now have one equation and one unknown.  Press F9 to solve or 
use the Commands Menu or toolbar icon.  TK displays the value of d, 1.25, in the output 
column.  Also, the * disappeared from the Rule Sheet and rule is marked as Satisfied.  
Look at the lower right corner of the screen.  TK displays the memory available along 
with an "OK" message.  OK appears after solving.  If any changes are made to the Rule 
or Variable Sheets, TK changes the OK to F9 as a reminder. 
 
3.  Switch to the Variable Sheet and enter 1.5 as an input for d.  Notice that the OK 
indicator has changed to F9.  Cursor to the input field for the variable a and press 
Spacebar and Enter to blank out the value.  Again, we have one equation and one 
unknown.  Press F9 to solve.  The solution for a appears in the output column. 
 
4.  Switch back to the Rule Sheet and place the cursor over the equation.  Press F5 or 
double-click to change to edit mode.  Edit the rule to read a+b = b*c . 
  
5.  Switch to the Variable Sheet and enter inputs of 2 and 3 for a and c and blank out any 
other input values.  We have one equation and one unknown.  Press F9 and...no solution.  
If an unknown appears more than once in a rule, TK’s Direct Solver cannot solve it. 
 
6.  Move the cursor to the status column of the variable b and type G or double-click and 
choose Guess to indicate that b will have an initial guess.  By default, TK places the last 
value entered as the guess value or 0 if no value has been entered yet.  We can enter any 
value we choose as a guess.  Press F9 again and a solution is found, b=1.   
 
TK’s Iterative Solver sent the guess value to the Direct Solver.  The Direct Solver 
detected an inconsistency and reported the value back to the Iterative Solver.  The 
Iterative Solver sent a new guess value and the process was repeated until the Direct 
Solver no longer detected the inconsistency. 
 



7. Switch back to the Rule Sheet and enter a second equation, a/b + 1 = c.  This is a 
different version of the previous rule and none of the variables appears more than once.  
Press F9 and TK solves for b directly with no guess needed. 
 
 
Now let’s practice with multiple equations.  Keep in mind that the same process is used.  
TK will use solutions from equations in trying to solve other equations.  In general, 
though, TK cannot solve an equation directly if it has more than one unknown or the 
unknown appears more than once. 
 
1. Use File New to reset all the sheets for the next lesson. 
 
2. Enter the following equations on the Rule Sheet. 
 
   y1 = 3*x^2 
   y2 = x*LN(x) + 20*x 
 
3.  Switch to the Variable Sheet, enter 50 as an input for y1 and solve.  Success.  The first 
equation has only one unknown, x, which appears only once.  Once x is known from the 
first rule, the value is used in the second rule to solve for y2. 
 
4.  Now give y2 an input of 50, blank y1 and solve.  No solution.  In this case, the first 
equation has two unknowns so TK skips it.  The second rule has only one unknown, x, 
but it appears more than once so TK cannot solve for it directly.  Try a guess for x and 
solve again.  Success.  Try a different guess for y1 and solve again.  Success again. 
 
What happens when we guess?  The purpose of guessing is to temporarily reduce the 
number of unknowns in an equation to one.  TK can then solve the equation and move on 
to others if necessary.  Eventually, TK will find an inconsistency in one of the rules and 
will then iterate on the guess value until the inconsistency is sufficiently small (less than 
1E-6 by default). 
 
5.  Add a third rule, y1 = y2.  Blank out any input values.  We now have three equations 
and three unknowns but none of the equations has only one unknown so we'll need to use 
a guess and iterate.  Does it matter which variable we guess?  See for yourself. 
 
Some guesses lead to error conditions.  In this case, if TK tries a value of x which is less 
than or equal to zero, it will report an error.  The second rule includes the expression 
LN(x) which is not defined for negative x values. 
 
6.  At this point, let's save our work.  Use the File Menu to Save As the file name 
WORK1.  TK saves all the sheets in one file.  Use File New to reset all the sheets. 
 
 



Special Topic:  Understanding TK’s Accuracy 
 
1.  Enter the rule  a = a+1.  Switch to the Variable Sheet, enter an input of 1 for a and 
solve.  TK reports an error.  TK’s Direct Solver detects an inconsistency because 1 is 
relatively different from 2.   
 
2.  Now change the input value to 1E7 and solve again.  No error.  The two sides of the 
equation are within TK’s “Comparison Tolerance”.   
 
3.  Use the Options Menu and choose Settings.  Change the Comparison Tolerance 
setting to 1E-9 and solve again.  This time TK notices the difference.  In practice, the 
default Comparison Tolerance of 1E-6 works quite well.  However, if you are working 
with problems involving very small or very large values, you may need to adjust this 
setting. 
 
4.  Use File New to reset and we'll move on. 
 
 
Guiding the Iterative Solver 
 
1. Load the WORK1 file. 
 
2. Activate the Rule Sheet and double-click in the status column of the third rule to 
cancel it so that the two original equations are the only ones used. 
 
3. Enter 50 as the input for y2 and blank any other inputs if there are any.  As we saw 
before, if we try solving at this point TK’s Direct Solver will fail.  A guess is required to 
launch the Iterative Solver.  We can automate that process. 
 
4. One of the properties for a variable is a first guess value.  If the Direct Solver does not 
make progress, TK looks for first guesses for any of the output variables and launches the 
Iterative Solver automatically.  Enter a value of 1 as the first guess property value for x.  
Notice that TK places an F in the status column for the variable. 
 
Status:
First Guess:

F
1  

 
Now when we solve, the Iterative Solver is automatically triggered. 
 
Status Input Name Output Unit Comment
F

50

x
y1
y2

2.39537704
17.2134935

 
 
 



Educated Guesses 
 
Remove the first guess from the x properties. 
 
For some problems the guess value must be chosen carefully and may need to change as 
one or more of the inputs change.  This can be accomplished by introducing an iteration 
trigger variable and then adding a rule to specify the required relationship.  In this case, 
consider the following equation. 
 
 y1 = y1g * y2 
 
If y1g is assigned a first guess value of 1, then y1 will start the iteration process with the 
same value as y2. 
 
What if we want to guess that y1 is half of y2?  Use the rule 
 
 y1 = y1g * y2/2 
  
As you can see, the extra rule can involve any expression you like. 
 
 
Real Solutions Only, Please 
 
If a guess is provided but is not sufficient to solve a problem, TK simply moves the guess 
value to the output field.  This may lead you to believe that solved the problem for you, 
however, it is merely one of an infinite number of possible solutions.  In situations where 
a default first guess is supplied as a variable property, you may not even realize that the 
Iterative Solver was triggered.  You can turn off automatic iteration via the Settings 
menu.  Under that condition, guesses must be provided manually by changing the status 
for one or more variables. 
 
If you have used a guess trigger variable, you can use conditional expressions to control 
when it will be used to relate two variables.  For example, 
 
 If given(‘y2) then y1 = y1g * y2/2 else y1g = 1 
 
In this case, the guess will only be triggered if an input is provided for y2. 
 
 



The Optimizer – A Different Approach to Equation Solving 
 
The Optimizer can also be used to find solutions to problems like these.  It takes a bit 
more effort to set up but it provides more control in the form of bounds and constraints 
that are not available with the Iterative Solver.  To use the Optimizer, you must have a 
license for the Premium Version of TK Solver. 
 
1. Load the WORK1 file. 
 
2. Activate the Rule Sheet and double-click in the status column of the third rule to 
cancel it so that the two original equations are the only ones used. 
 
3. Input a value of 1 for the variable x, blank any other inputs and solve. 
 
Status Input Name Output Unit Comment

1 x
y1
y2

3
20  

 
4. Suppose we want to determine the value of x that results in an output of 50 for y2.  Pull 
down the Wizards menu and launch the Optimizer Wizard.  Select y2 as the objective 
variable, with the goal to reach a value of 50.  Click Next. 
 

 
 
5. Select x as the decision variable.  In this case, there are no bounds required, so we 
leave the >= and <= fields blank.  Click Next. 
 



 
 
6. In this case, there are no additional constraints, so click Finished to launch the 
Optimizer, then click Exit to close the Wizard and view the solution in TK. 
 

 
 
Here is the variable sheet showing the results from the Optimizer. 
 
Status Input Name Output Unit Comment

2.39537704 x
y1
y2

17.2134934
49.9999999  

 



The Optimizer works as a shell around TK Solver, repeatedly trying new input values, 
solving (F9) and observing the results until the goal is achieved.   
 
The Optimizer uses the current values of the decision variables as initial guesses.  
Different starting points may result in different solutions.  Additional constraints can be 
added to guide the Optimizer in finding a particular solution. 
 
There is a second way of accessing the Optimizer set up screen – Commands, Setup 
Optimizer. 
 

 
 
The Wizard offers a series of screens to guide you while the Commands option provides 
a more concise interface.  Use whichever you prefer. 
 
In either case, once you have set up the Optimizer for a particular TK model, the 
configuration is saved with the model.  This means that if you make changes to the 
model, you can automatically re-run the Optimizer by pressing F11 without having to go 
through the set up process each time. 
 
7. Edit the second rule as follows: 
 
 y2 = x*LN(x) + 15*x 
 
8. Press F11 and the Optimizer finds the new value of x. 
 
Status Input Name Output Unit Comment

3.09957119 x
y1
y2

28.8220247
50.0000004  

 



 
Equation Solving Summary 
 
Direct Solver:   
One equation, one unknown appearing just once 
Automatically inverts functions wherever possible 
Uses results from equations in trying to solve others 
Makes multiple passes through the rules until no progress can be made 
 
Iterative Solver:   
Sends guess values to the Direct Solver and receives inconsistencies back  
Iterates on the guess values until the inconsistencies are relatively small 
First guesses can be assigned as variable properties 
Guess triggers can be added for educated guesses 
 
Optimizer: 
Repeatedly runs a model until an objective is achieved 
Initial inputs are used as starting guesses 
Allows for bounds on any of the decision variables 
Allows for constraints on any expressions in the model 
 
 
Quiz/Practice Problem 
 
Solve the following equations for x and y, for A = 3.9 and B = 0.75: 
 
 A = exp(x) + x*y 
 B = sin(x*y) + x + y 
 
1. Use the Iterative Solver.  Does it matter which variable you guess?  Do all guess values 
lead to the same solution? 
 
2. Use the Optimizer.  You can use either A or B as the target variable and add the value 
of the other variable as a constraint.  Use x and y as the decision variables.  Do all guess 
values lead to the same solution? 
 
The solution values for x are 1.466498, 2.031738, and 2.206181.  Did you find all three? 
 
Now let’s see how we can use TK Solver to investigate sets of equations like these using 
ranges of input values in tables and plots. 
 
 



List Solving 
 
List Solving is the repeated processing of the rules over ranges of inputs stored in lists.  
Any model that can solved once can also be list solved.  Here are the steps required: 
 
Make sure the model solves once using typical input values. 
Associate lists with inputs and outputs (and guesses if necessary). 
Fill the input (and guess) lists with values. 
Use the List Solve command. 
 
Let’s try it.  Load the WORK1 file again with the following two equations. 
 
 y1 = 3*x^2 
 y2 = x*LN(x) + 20*x 
 
We will use TK to List Solve and create a table and plot showing how y1 and y2 vary as 
x goes from 1 to 10. 
 
1. Enter 2 as the input for x, blank any other inputs, and solve. 
 
Status Input Name Output Unit Comment

2 x
y1
y2

12
41.3862944  

 
2. Associate lists with each of the three variables by double-clicking in the Status column 
and choosing List.  You can also type an L to assign List status to a variable.  It is a 
toggle, turning the list status on and off. 
 
3. Move to the input field for x, click the Commands menu, and choose List Fill. 
 

 
 
4. Choose Linear and Fill By Step, First Element 1, Step Size .2, First Value 1, and Last 
Value 10.  Then click the Fill List button. 
 



5. Use the Object Bar or Navigation Bar to view the 46 values in the x list. 
 
6. Click the Commands menu and choose List Solve or press F10.  TK solves the rules 46 
times, using each of the x values as inputs and storing the results for y1 and y2 in the 
associated lists. 
 
7. Use the Navigation Bar to open the Plot Sheet.  Create a new plot called p1 and specify 
that x is the x-axis list and y1 and y2 are the y-axis lists.  View the plot via the Object Bar 
or using the Commands menu. 
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8. Edit the properties of the plot to add labels and indicate which line is which. 
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9. Follow similar steps to create a table displaying the three lists together. 
 



The List Solve Wizard 
 
The previous example took us through all the steps involved in using List Solving to 
generate plots and tables of solutions.  Good news… many of these steps have been 
automated via the List Solver Wizard. 
 
1. Use File New to reset TK and enter the rule y = sind(x) on the rule sheet. 
 
2. Enter an input of 30 for x on the variable sheet and solve (F9). 
 
3. Use the Wizards menu to launch the List Solver Wizard.  As you can see, the first step 
is to make the model solves for a single value and you have already done that.   
 

 
 
4. Press Next to continue to step 2, variable selection.  In this example, we have just one 
input and output to choose from but you can store as many outputs as you like.  It is 
during this step that TK is associating lists with the selected variables. 
 



 
 
 
5. Click Next to proceed to step 3, filling the input list.  Choose Linear and Fill By Step, 
with Step Size 3, First Value 0 and Last Value 360. 
 

 
 
 
6. Click Next to go to the 4th and final step, naming the resulting table and plot. 
 



 
 
 
7. Click Next to close the wizard and view the table and plot. 
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Here’s a portion of the table.  The Wizard saves a lot of keystrokes and mouse clicks! 
 
Element x y
1
2
3
4
5
6
7
8
9
10
11

0
3
6
9
12
15
18
21
24
27
30

0
.052335956
.104528463
.156434465
.207911691
.258819045
.309016994
.35836795
.406736643
.4539905
.5  

 



List Solving with Iteration 
 
If iteration is required during List Solving, you must do one of the following: 
 
 • provide a list of guesses (variable status LG). 
 • provide a default guess value on the variable subsheet (variable status L). 
 • extrapolate -- use the previous solution as the next guess (advanced). 
 
This topic is covered in detail in the Advanced Training document but the concepts aren’t 
particularly difficult.  Guess extrapolation in list solving involves the use of the ELT and 
PLACE functions to determine the current element number during list solving and place 
the current value into the subsequent element where it can be used as the next guess.  
Here is an example, assuming the status for variable x is LG. 
 
 place(‘x,elt()+1) = x 
 
If the x list has an initial guess in element 1, this rule will place the computed value into 
element 2. 
 
Higher order guess extrapolation is also possible using similar logic. 


